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Staff Menu

Commands in this menu are used to create staves, delete
staves and to set the properties and attributes for the
active staff.

New Staff Ctrl + A

This command adds a new staff at the bottom of the
active score.
The properties for the staff may be set through the
Staff Properties command or key F2.
If required the staff may be moved to another position
in the score using the Move Staff command.

Import Recording

Use this command to import a recording that has been
stored in the record buffer automatically as part of the real
time recording procedure.

This command is directly relevant to the importation of a
recording for which the “Buffer Only” record option has
been chosen in the Tools - Options - Record dialogue
box.
However, the command may be also used to import and
control the resolution of recordings made under other
options.

• Execute Import 
Recording to display 
the Import Instruction 
box.

• Select the import 
options required.

• Click on Ok

A new staff will be created
at the bottom of the active
score partition.
The attributes for the
imported staff may be set
through the Staff
Properties command (F2).
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Move Staff

Use this command to move the active staff to another
position in the score.

• Execute this command - the Move Staff dialogue box
will appear.

• Click on the new staff position in the list displayed.
• Click on OK to exit.

The active staff will replace the staff selected in the list.

Delete Staff Ctrl + D

This command will remove the active staff f rom the score.
The staff may be recovered using the Undo command.

Playback Instrument

This command allows you to change the default
instrument or program patch assigned to the
active staff.
You can still i nsert instrument patches within the
body of the staff to change the instrument sound
during playback.

• Select the instrument patch required.
• Select the patch list type - the type selected 

controls how the patch names are displayed 
in the list.

• If your sound card or external instrument 
supports patch banks you can select a 
different bank and bank number.

• Click on OK to exit.

Mute Staff

This command is a toggle that will mute or unmute the
active staff depending on the current status.

If the staff is already muted the menu item will be checked
and the tool icon will be highlighted.
Executing the command on a muted staff will change the
staff status to unmuted.

A muted staff will not sound during playback and the staff
note events will not be included in an exported MIDI file.
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Staff Properties F2

Executing this command displays the Staff Properties
dialogue where you can set the attributes affecting the
appearance and playback of the active staff.
The dialogue box is divided into three tabbed sections:-

General Properties

In this section you can name the active staff and assign
the staff to a Group.

• Enter a name for the staff - this will be the name
that will appear on the printed score and the
performance part.

• Enter or select the Group name required.
• Select another tab or click on OK to exit.

The score may be divided into sections or groups
containing related staves - Rhythm, Brass, Saxes for
example. The default group is the Standard group.
Each named score group can be selected and displayed as
a unit through the Page Setup in the File menu.
A staff can only appear in one group but may be moved
between groups from this dialogue box.

Visual Properties

This section is used to enter the properties that affect the
appearance of the active staff in the display and on the
printed score and parts.

• Enter the Upper and Lower sizes for the 
spacings above and below the staff.
This space is required to allow for ledger 
lines, slurs and text notations that may be 
added to the notation.
Values entered here affect the spacing of 
the staves in the display and on  printed 
parts.
Both values may need to be adjusted when 
trying to fit the score or part to the printed 
page.

The upper and lower limits of all staves may be displayed
by enabling the Staff Frame in the Options/Editor
dialogue box under the Tools Menu.
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• Select a style for the staff .
The available styles are :-

* STANDARD - the staff will not have a brace at 
the far left and bar lines will not connect with 
staves above or below.

* UPPER AND LOWER GRAND STAVE -
the upper staff will be braced with the lower staff 
to form a grand stave.

* ORCHESTRAL - all staves will have connected 
bar lines and a decorative corner at the start of 
each system.

MIDI Properties

In this section you can set the playback and MIDI file
parameters for the active staff.

• Select Mute Staff if this is required.
Muting the staff silences the staff during 
playback and will omit the staff f rom a 
MIDI file export.

• Select or enter a default volume for the 
staff (0-127).

• Select or enter the staff sound stereo pan 
(0-127),  a value of 64 is centred.

• Select or enter a sound transposition for 
the staff. The value entered is in semitones 
above (+) or below (-) the written pitch of 
the staff.

• Select a playback device from the arrow 
list. This must be a device, port, sound card 
or external instrument that has been 
configured for use with Windows.

• Select or enter a channel for the staff.
There are only 16 channels available.
In general assign similar instruments to the 
same channel. Channel 10 (in some cases 
Channel 16) is reserved for percussion 
sound.

• If you wish to change the Instrument Patch, 
click on the Change button.
This will display the Instrument Patch 
dialogue where you can select an
instrument sound, patch type, sound bank 
and number.

Standard

Upper and
Lower
Grand Staff

Orchestral

� � �� � �
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Insert Menu

The commands in this menu are used to add items to the
score. These include notes, rests, barlines, dynamics,
endings, clefs, key and time signatures, text and varoius
other markings.

The menu also includes items affecting the playback
including instrument patch changes and MIDI control
items such as pitch wheel, volume and tempo variations.

Note Enter

This command enters a note with the current
duration at the insertion point within the active
staff.
The Enter key is the most direct way to enter a
note.
The right mouse button may also be used to select
the note pitch and access this command through
the mouse menu.

Rest Spacebar

Use this command to enter a rest with the current
duration at the insertion point within the active
staff.
The Spacebar provides the most direct way of
entering a rest.
This command may also be accessed through the
mouse menu by clicking the right mouse button at
the insertion point.

Chord Member Ctrl + Enter

Individual notes may be added to an existing note to form
a chord using this command.

• Select the required note duration and any accidental 
using the toolbar or keyboard shortcuts.

• Position the insertion point cursor to the right of the 
existing note or chord.

• Select the pitch with the arrow keys or mouse.
• Execute this command to enter the note into the 

chord.

The command may be entered using this menu command,
the keyboard shortcut or through the mouse menu.

    �
 ��
          

����   

Cursor Here
Then Ctrl + Enter

  Before          After
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Chords, split-stem chords and multi-line staves.

A chord is capable of supporting notes of two differing
duration and/or differing stem directions.
If the new note's stem direction and note position is
consistent with the note, rest, or chord to the left of the
insertion point, then the new note is combined with the
item to the left.
When combining notes with a previously placed rest, the
stem direction tools can be used to control whether the
notes appear above or below the rest.

The following rules apply to entering chords:-

1. Two notes with the same pitch but differing duration 
or stem direction cannot be added to the staff.
In addition, two notes at the same vertical position but 
with differing accidentals cannot be added to the same 
chord. Use the enharmonic equivalent for one note.

2. You cannot add a third duration to an existing chord 
that already has two different note durations present.

3. A chord containing a rest is created by first placing the 
rest, and then adding one or more notes to that rest. 
The duration of the rest must be smaller than that of 
the added notes .
The stem direction assigned to the rest must be
different (opposite) to the notes being added.

4. A note with its stem going downward cannot be 
combined with a lower note which has its stem 
going upward. The reverse is also true.

5. It is only possible to beam, triplet, or slur the
notes of the shorter duration in the chord.

The smaller duration items are used in aligning notes on
the score.The larger duration are ignored when
formatting and alignment is performed.

Chord members can be added most efficiently by pressing
Ctrl + Enter from the computer keyboard.

Chord members can be removed from a chord  by
pressing Ctrl + Backspace when the insertion point is
directly to the right of the note to be removed.

Remember!

A Rest  has an invisible
stem direction.
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Bar Line Tab

Use this command to add a standard bar line at the
insertion point.
Bar lines must be added manually during note entry to the
end of each measure on every individual staff in the score.

If the correct durations have been entered in each staff the
bar lines should line up throughout the score.
If any bar lines are misaligned this indicates that one or
more measures contain an incorrect duration count with
respect to the time signature.
The Refresh Score command (Ctrl + F9) may sometimes
correct errors due to whole measure rests that assume a
temporary duration.

The command Audit Bar Lines in the Tools menu may be
used to add or correct bar line positions within a staff, but
this may change the rhythmic structure of the staff if
existing note durations cross a bar line position.

Bar Line Decorated B,b

Use this command to insert various types of barlines
and repeats.
When the command is executed the Bar Lines
dialogue box is displayed allowing you to insert one
of  the following bar line types:-

Single: A standard bar line
(see Bar Line Symbol Command).

Double: A double bar line - used to denote a 
new section in the score.

Section Open/Close: Used at the beginning and end 
of a section of the score.

Local Repeat Open/Close: Repeat symbols that allow a
section to be repeated for a specified number of 
times. When executed a dialogue box opens to 
allow the number of repeats to be selected.

Special endings (first and second time bars) do
not apply to local repeats, they may only be used 
with the Master Repeat bar line type.
Local repeat loops are performed even after a D.S. 
or D.C. flow direction has been executed.

        

    �      

    �      
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Master Repeat Open/Close: Repeat symbols for 
repeating a section with Special Endings (first and 
second time bar style).
The Special Ending Command is used to add the 
required endings after inserting the Master Repeat 
Close symbols.
A Master Repeat Open/Close pair without a special 
ending will default to a two iteration repeat.
The closing repeat mark is ignored after a D.S. or D.C.
flow redirection has been initiated, the Default ending 
(D) is taken instead.

All repeats in a score must be added to each individual 
staff so that play back will be compiled correctly.
The score printout will automatically display the repeat 
symbols at the proper position in a score system when 
all staves in the system have been assigned the same 
bar line types.

Clef C,c

This command inserts a clef at the insertion point.
The type of clef and the octave transposition for sound
playback are selected from the Clef dialogue box that
appears when the command is executed.

• Select the required clef from the arrow list.
Avalable clefs are Treble, Bass, Alto and Tenor.

• Select an octave shift for the sound playback if 
required. Choices are None, Octave Up and Octave 
Down.

An Octave Down shift will produce sound that is one
octave below the written pitch of the staff.
This is useful for bass, guitar, bass clarinet which sound
an octave lower, and also for alto and tenor saxophones
written in concert score to avoid lower ledger lines.

An Octave Up shift could be used for piccolo which
sounds an octave above written pitch.

If you change a clef press F9 to audit the staff and update
the key signature for the new clef.

� �  1.2. � �  3.D. �
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Dynamic D,d

This command inserts a dynamic mark of your choice at
the insertion point.

The command will display a dialogue
allowing you to choose the dynamic
required.These control the MIDI note
on velocity and MIDI note volume
with which a particular note is
sounded.
The symbol is placed at the vertical
position of the staff where the
insertion point is currently located.
You may specify another staff position
in the dialogue box.
The Preserve width item will open
space between notes to display the
dynamic. If this item is not checked
the dynamic may spill across, above or
below, the following notation item.

Currently, the default MIDI velocities used by
NoteWorthy Composer when interpreting score dynamics
are as shown in the table at left.

You can override these and assign your own
MIDI velocity.
If you override the velocity with a zero velocity then the
dynamic will not alter the current running MIDI velocity
in the staff.

By default, a dynamic does not alter the MIDI volume of
the channel being utili zed to play back the current staff.
You can change this  by overriding the MIDI volume
 and specify a MIDI volume of your choice.
If you specify a override MIDI volume value of "-1" then
no MIDI volume change will be triggered.

• Select the required dynamic from the arrow list.
• Overide defaults and enter values as required.
• Choose to preserve with or not as required.
• Select a staff position for the dynamic.
• Choose to hide during printing if required.
• Click on OK to insert the dynamic mark.

The changes of a dynamic can be gradually
phased in by using the Dynamic Variance command
described in the following section..

NoteWorthy Composer
Default Note Velocity

     MIDI                 
Dynamic  Note

    Velocity
        ppp 10

pp 30
p 45
mp 60
mf 75
f 92
ff    108
fff    127

Dynamics with
width preserved and

not preserved

  � � �
mf
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Dynamic Variance Y,y

Use this command to insert a
dynamic variation mark at the
insertion point.
The dynamic variation may also be
reproduced during playback.

When a dynamic variance mark is
encountered during MIDI play back,
the staff is searched on either side
for dynamic marks.

If they are found on both sides, the transition from the
previous dynamic to the next dynamic is introduced
gradually into the play back of the staff.
If the mark does not have a dynamic on both sides of it in
the staff, it does not alter play back dynamics in any way.
This is applies to both volume and note velocities.
The dynamic variance is actually controlled by the
dynamics on either side of the mark.
A crescendo will produce a decrescendo if the dynamic
marks on either side indicate a decrease in volume.
Repeats and flow direction marks are ignored when
determining the dynamic that follows the variance.

Only the Crescendo and Decrescendo styles exhibit the
variance behavior described above.
The Diminuendo, Rinforzando, and Sforzando styles are
ignored during MIDI play back.

• Select the type of dynamic variance required.
• Select to preserve width or not as required.
• Select staff position.
• Click on Ok to insert the variance mark.

Flow Direction F,f

This command inserts a flow direction mark at the
insertion point in the active staff.
The flow control will be followed during MIDI
playback.

The symbols must be added to each staff in the
score partition in order to produce the desired play
back result.

      �
mp

� � � � �
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The symbols associated with each command are placed in
the appropriate vertical position on the staff.
Several examples of repeats and flow direction marks can
be found in the Samples directory (folder).

The instructions and marks supported by this command
are shown at left, they include:-

Segno: This places a Segno symbol into the staff where
play should resume after any Dal Segno type instruction.
This marker is ignored unless a Dal Segno mark is used
later in the score.

Coda: This places a Coda mark into the score to mark the
location where play will resume after a To Coda
instruction is performed.

To Coda: This places an instruction into the staff that
tells the performer to advance to the Coda mark that
appears elsewhere in the score. This instruction is ignored
if neither a Da capo nor Dal Segno has been performed.

Da capo:   D.C. al Coda:   D.C. al Fine:
These instructions are all considered to be Da capo, or
D.C. instructions. Playback will be redirected back to the
beginning of the song.

Dal Segno:     D.S. al Coda:  D.S. al Fine:
These instructions are all considered to be Dal Segno, or
D.S. instructions. Playback will be redirected back to the
Segno mark placed earlier in the song.

Fine: This item is used to stop playback of a
song after a Da capo or Dal Segno instruction
has been performed, otherwisethis item is ignored.

Playback Restrictions:
After Dal Segno or Da Capo all master repeats will be
ignored, and only default special endings marked with a D
will be performed.

Master repeats are enabled after a To Coda instruction.

Local repeats after D.C. or D.S. are performed normally.

Da Capo and Dal Segno instructions should not be mixed
in the same song.

NoteWorthy Composer
Flow Direction Marks
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To Coda
 

      

      

D.C.

      

      

D.C. al Coda

      

      

D.C. al Fine

      

      

D.S.!
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Key Signature K,k

Use this command to insert a  key signature at the
insertion point.
A dialogue box will be displayed allowing the required
key signature to be selected.

The selected key signature remains the
default, as the user defined key, until
changed.

When the key signature of an existing
section is changed, the note attributes
within the section remain unaltered.
The accidentals within the section may
be updated to reflect the new key
signature by executing a Transposition
of zero semitones.

Key signatures are not automatically
added to all staves in a score.  Each staff
must be assigned the appropriate
key signature.

A key signature designating the key of C is displayed as a
single natural sign in the score editor to show that a key
signature is present in this location.
When the score is printed the natural will not appear.

A Score Refresh (F9) may be required to update the
position of a key signature after a clef change.

Performance Style P,p

This command is used to insert a performance expression
into the staff.

You can select among many
common expressions from the
arrow list in the dialogue box.

The expressions are intended as
instructions for the performer.
Only two styles affect the
playback of the score.

Legato causes notes to be played to their full duration.
Staccato causes notes to be played at shorter duration.
All other styles change play back to the default.

Quick Tip

Always   enter a key
signature for C major or
A minor or transposition
will not perform as
expected.

" " "
      

# $
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staccato
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Special Ending S,s

This command is used to insert a numbered ending, such
as first and second time measures, within a Master Repeat
loop strucure.
Up to seven standard endings are possible.
Endings may be combined . For example; the 1st ,2nd
and 3rd endings may use the same measures.

No repeats will be performed in a
master repeat loop after a D.S. or D.C.
instruction, the last ending, (Default
D.S./D.C. Ending), is performed on
the first iteration to exit the loop.

The final ending and the default ending
are usually followed by a Section Close
bar line to designate the end of the
master repeat section.

The first ending marker must only appear once within a
master repeat, it must always appear before any other
special ending, and must be concluded using a Master
Repeat Close bar line.
A special ending may be longer than one measure, but
only the first measure will contain a printed marker line.

Special endings should be added to all staves in a score
partition so that playback is performed properly.
Special Endings will only appear on the top-most staff in a
system when the score is printed.

Sustain Pedal U,u

This command adds a Pedal down or Pedal
released symbol at the insertion point in the
active staff.

The Sustain Pedal control will be echoed by
the MIDI playback of the staff.

• Select the required Pedal symbol from the arrow list.
• Click on OK to enter the symbol.

' (  1.2. ( '  3.D. (
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Tempo T,t

Use this command to insert a tempo indication at
the insertion point in the active staff.

This controls the speed at
which the song will playback
and indicates the tempo to the
performer on the written part.

The tempo is designated as the
number of beats per minute of
the selected time base (note
duration) unit.

Tempo indicators should preferably be placed in only one
staff for MIDI playback purposes. However you may find
it necessary to repeat the tempo on all performance parts.
An optional text expression may be used to indicate the
tempo to a performer. This expression is ignored by MIDI
playback.
When printing the part you can elect to print both types of
tempo markers, one only or neither.
The tempo mark is always indicated in the editor, whether
it has been selected for printout or not.

Tempo Variance E,e

This command is used to insert a tempo variance mark at
the insertion point in the active staff.

The tempo variance will be reflected in MIDI playback.

The following tempo variance styles are supported:-

BreathMark

The breath mark is represented
graphically in the score and indicates
that the performer should take a
breath at this position.
You can optionally specify a delay(in
16th notes) which will i nfluence the
play back of the staff.
The delay should only be specified
for one instance of the mark at any
given vertical position in the song.

      . /  =120

      

      0 Moderato ( 1  =120)

      

      2 3 4 3       



Command Reference - Staff and Insert Menus

� � � �

Fermata
The fermata is similar to the breath mark in that it is
represented graphically in the score and has a
corresponding delay.
The differences are in both appearance, and how the delay
is implemented. The fermata delay is designed to influence
the note that immediately follows the fermata (the breath
mark influences the gap between notes).

The other marks (Accelerando, Allargando,
Rallentando, Ritardando, Ritenuto, Rubato, and
Stringendo) do not use a predefined delay.
They scan on both sides of the variance event to find the
presence of tempo marks.
If they are found, then the change from one tempo to the
next is introduced gradually at a rate determined by
the distance up to the next tempo mark.
If a tempo mark is not found either before or after the
variance mark, then no change in the tempo is introduced
into the play back of the staff/score.

The playback tempo variance is controlled by the tempo
marks on either side of the tempo variance; not   by the
type of variance. It is possible to create a section which
slows down in tempo and yet is labeled as Accelerando.

Text X,x

This command may be used to enter a text expreession,
performance instruction or chord symbol at the insertion
point in the active staff. The text expression is ignored
during MIDI playback.

If the Preserve Width option is
selected the staff items to the right will
move to create room for the text.
If the Preserve Width option is not
enabled the text will flow across the
following note or rest item and may
have to be located at a vertical position
above or below the item to avoid
conflict.

If the text width is not preserved a small non-printable
marker precedes the text to allow text selection

The Staff Position and Font Style (Bold or Italic) can be
selected from the dialogue box.

      5 5 6 78       
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Time Signature G,g

This command inserts a Time Signature at the insertion
point on the active staff.

The Time Signature may be added as a standard
time signature by entering or selecting the beats
per measure and the note duration value for the
beat in the arrow boxes in the dialogue.

Optionally, you may select a Common Time or
Alla Breve symbol from the lower Arrow list.

Time Signatures must be entered (or copied) on each staff
in the score.
NoteWorthy Composer does not automatically insert bar
lines to conform with the time signature.
Bar lines must be entered manually at the end of each
measure during note entry.
However, it is possible to locate or adjust bar lines
following a time signature by executing the Audit Bar
Lines command from the Tools menu.

Instrument Patch I,i

This command inserts an Instrument Patch MIDI control
at the insertion point in the active staff.
Normally a staff will be dedicated to a single instrument
which will be assigned to the staff throught the Staff
Properties command or the Playback Instrument
command in the Staff menu.

This command is provided to allow a change of
instrument sound at a pre-defined point in the
score during MIDI playback.
For example:-  A trumpet changing from open
to muted style in one section of the song.

The dialogue box displayed by this command is
identical to the Playback Instrument dialogue
described on page 11.?

• Select the Instument Patch type.
• Select the required Instrument Patch
• If supported by your sound device -      

Select a different patch bank number if 
required.

    @ A A BB     
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Multi Point Controller L,l

This command enables MIDI controller and tempo
changes to be inserted into the song during play back.
The changes can either by absolute changes, or the item
can be instructed to gradually produce the change (Linear
Sweep).
This symbol can be used for sophisticated
control over the performance of the song.
For example, it can be used to:
• fade a part in or out during a song
• gradually speed up or slow down a selection
• change the pitch of a sustained note (pitch bends, 

and scoops)

The notation item produced from this command can only
be seen from within the score editor.
The display associated with this command does not get
printed.
This item can be changed using the Edit Selection
command.

When this command is invoked, the MIDI Controller
Specification dialog is presented.
It contains the following information:

MIDI Controller Specification

Controller: This is where the type of MIDI controller 
to be implemented.

The dialogue box is similar
for all types of multi-point
controller.

The controller values differ
according to type.
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You can chose from:

TEMPO Controls the speed of the performance.

VOLUME  Controls the loudness of the performance.

STEREO PAN
Controls the perceived stereo location of the sound.

BREATH CONTROL
For instruments which support it, this controls the
parameter designed to simulate wind flow into the
instrument

PITCH BEND
Useful when used to change the pitch of a sustained note,
produce falloffs or scoops. Always return the last control
point to zero.

Style:
You can set up to 4 control points with different values
for the controller you specify.
This field allows you to specify the algorithm
that will be used to interpret the control points.

Absolute
Only the specific values will be performed.

Linear Sweep
Changes between the control points will be changed
gradually over the time specified

Time Offset Multiplier:
The numeric values that you place into the Time Offset
field for each control point are relative times.
They are converted to absolute musical intervals by
multiplying them by the time offset multiplier specified
here.

Linear Sweep Contour:
This field can be used to control how dense a series of
control changes will be when the Linear Sweep
control change style.
The larger the value you use, the fewer actual control
changes will be used during the linear control sweep.
This is most useful for pitch bends, as a very large
number of control changes are possible when sweeping
the pitch over its full range, thus overflowing the MIDI
data stream.
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Control Point Settings:
The lower area of the dialog is where you actually can
define up to four control points.
The first point is automatically enabled, so there is not an
enabling checkbox.
The other three points have a checkbox which you use to
enable the corresponding control point.

Time Offset:
The time offset for each control point gets multiplied by
the Time Offset Multiplier field and then added to the
current song position.
This is how you specify when the control point should be
initiated.
Each control point's time offset is added to the previous
control point's event time.
This means that Setting 3 will always occur sometime
after Setting 2, and so on.
The time offsets do not change when particular notes are
played that follow after the controller item in the staff, so
one controller item can influence a series of note events.

Controller Value: The scroll bars next to
each setting control the value associated with
that control point. The range of the control
point varies with the type of controller that
has been specified.

Special Note:
Inserting a Multi-point Controller that contains control
points that are scheduled at time offset well beyond the
current beat can significantly add to the hesitation time
between when you request play and actually hear the song
start to play back.
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Notes


